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Kim Greene - Introduction

* Owner of Kim Greene Consulting, Inc.

e www.kimgreene.com
o HCL Collaboration Solutions

e Services offered include:

» System and application performance optimization

* Administration IBMCHAMPION X &~
» Upgrades
» Troubleshooting \‘IHCLAmbassador

» Health, performance, security, etc. reviews
» Custom development

» Enterprise integration

» Migrations

e Blog: www.dominodiva.com
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- Michelle Smith - Introduction

e Owner of an IT consulting company
* M.E. Smith Consulting

» Started fixing IT issues during University work terms and

learned | loved solving the ‘puzzles’

* First exposure to Lotus Notes and Domino was migrating a

non-Y2K compliant email environment to Domino
* Focus areas:
» HCL Collaboration Solutions

* Work with Kim to support a group of amazing clients!
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Previous Webinars You May Find Helpful

Domino for Newbies — Administration, Part 1
https://youtu.be/Ob2cy3pURIg

Domino without Downtime: The Clustering & DBMT Blueprint for Continuous Availability
https://youtu.be/GOzVXfZg2Wo

Domino Administration: Things Lurking You May Not Be Aware of and How to Fix Them
https://youtu.be/QHcicigsWdA

Deep Dive into Debugging Domino with the Divas and “the Dude”
https://youtu.be/yf2 NzSQlzk

All slide decks can be found here:
https://openntf.org/webinars



https://youtu.be/Ob2cy3pURIg
https://youtu.be/Ob2cy3pURIg
https://youtu.be/GOzVXfZq2Wo
https://youtu.be/GOzVXfZq2Wo
https://youtu.be/QHciciqsWdA
https://youtu.be/QHciciqsWdA
https://youtu.be/yf2_NzSQIzk
https://youtu.be/yf2_NzSQIzk
https://openntf.org/webinars
https://openntf.org/webinars
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Console commands
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Notes.ini maintenance

Upgrade planning
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Templates

Language packs
Semaphore timeouts
Performance

SSL certificate renewal

What you should be doing and when






Server Tasks

Perform critical administrative, routing and maintenance operations

Most are set to start automatically via these notes.ini variables

ServerTasks=
SERVERTASKS=Replica,Router,Update,AMgr,Adminp,Sched,CalConn,RnRMgr,POP3,HTTP,collect,LDAP,LEI

ServerTasksAtX=
SERVERTASKSAT2=Updall
SERVERTASKSAT19=Catalog

Tip: To see which tasks start automatically, issue SHOW CONF SERVERTASKS* at the console

SERVERTASKS=Replica,Router,Update,AMgr,Adminp,Sched,CalConn,RnRMgr,CertMgr,LDAP,imap,TRAVELER
SERVERTASKSAT1=Catalog,Design

SERVERTASKSAT2=UpdAll

SERVERTASKSAT5=Statlog



Server Tasks

® Can be run manually

* Some examples
load updall

load design

® Can be scheduled via Program documents

Bas I Admi n|st'at|on

e R
= SNEER N

Basics
Program name: UPDALL Enabled/disabled: Enabled
Command line: OpenlLog.nsf -T CleanuphaentView Run attimes: 10:30 PM each day
Server to run on: Dorr Repeat interval of: 0 minutes
2020-11-11 (M5): Created to force the cleanup agent view to be refreshed before the agent starts in order to prevent the agent fram Days of week: Sun, Mon, Tue, Wed, Thu, Fri, Sat

Comments:

pausing while it is rebuilt




Server Tasks

Messaging / Mail

Router

Routes and delivers mail between servers
and mail files

SMTP

Handles outbound/inbound Internet mail

MTC (Message Tracking Collector)

Records routing data for message
tracking

IMAP / POP3

Provide client access protocols to
mailboxes

|
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Database Maintenance

Updall
Updates view indexes and full-text
indexes

Compact
Reduces database size and reorganizes
storage

Fixup
Detects and repairs database corruption

Design

Applies template updates to databases



“Server Tasks

Scheduling / Calendar

Calconn

Handles free/time scheduling requests between
servers

Sched

Calendar scheduling services (availability
lookups)

Administration / Automation
AdminP

Automates administrative changes (rename, ACL
updates, etc.)

AMgr (Agent Manager)

Executes scheduled and triggered agents

Web / Client Access
HTTP

Enables web access (Verse, iNotes, apps)

LDAP

Provides directory services to LDAP clients

DIIOP

Enables Java/CORBA access to Domino data

Directory / Infrastructure
Catalog
Maintains database catalog
Dircat
Builds and updates directory catalogs

Domidx
Provides domain-wide search indexing
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Server Tasks

Add-on Tasks
Run as a “service” within a given Domino server

Examples:
Traveler
Mobile sync (mail, calendar, contacts)
Nomad
Delivered via HTTP + Domino services (no unique core task; uses HTTP stack)
HEI / LEI
Data integration (runs as add-in tasks / connectors)
HTMO
Outlook sync components (uses HTTP + mail services)

Best to have these isolated (ex: don’t mix HTMO, Nomad, Traveler, ... with an Application or Mail
server)
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- Console Commands

* Used to monitor and troubleshoot Domino server
® Provides real-time interaction with the server

® Command syntax
e command [task] [parameters]

* Examples
e show server
e tell router quit
e |oad router
e restart task http
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Console Commands

Getting to the console - Domino Administrator client
[File -> Open Server ->] Server -> Status -> Server Console

e W ey gey v e W
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Console Commands

Issuing commands

Enter in “Domino Command:” prompt

Click the caret to display list of recent =2

commands

ell adminp process interval I“-[\é Send |'|

Simply select a recent command to
resu b m it Basic Ports... ] Server Tasks... ] Internet Protocols... ] B

1 . Full Access administrators:  Domino Administrator |
I p . Developers\T 7
Domain Admin

Peter I ST 3

Settings in Security section of Server N _______
document control who can work with o it

" Steus i v

Database Administrators:
t h e CO n SO | e ﬁull Remote Console Kim Greenell
Administrators: Domine Administrator!
SArchive_Administrators
ShArchive_servers

View-only Administrators:

System Administrator:

Restricted System
dministrator: )

Restricted System
Comman ds:
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Common Console Commands
Server status & monitoring Task control
show server load <task>
Displays server status (uptime, memory, Starts a server task
load) Ex: load http
show tasks tell <task> quit
Lists all running server tasks Stops a running task
show users Ex: tell router quit
Displays active user sessions Caution: quit ends the server! A
show stat restart task <task>
Displays server statistics Restarts a service
show stat <statistic> Ex: restart task http

Ex: show stat mail (mail-related stats)
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“Common Console Commands

Mail troubleshooting
tell router show
Displays mail routing status
tell router update config
Reloads routing configuration

tell router retry
Retries mail delivery queue

Replication
replicate <server> <database>
Forces replication

Replicate
Runs all scheduled replications immediately

Administration process

tell adminp process all

Processes all new & modified immediate,
interval, daily and delayed requests

tell adminp process new
Processes newly created requests

Tell adminp process interval

Processes all immediate requests & those
normally processed according to the Interval
setting in the Server document

Setting debug

set config <variable>
Ex: set config debugrouter=3

Remember to disable once done!
set config debugrouter=0






Policies
Centralized way to manage user and client configurations

Define defaults, persistent values, and rules applied to:
Notes clients
Mail configurations
Security
Etc: i

Great way to enforce consistent configuration settings for users

Flexible in how can be applied
Entire organization
Groups of users
Individuals
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Policies

Two types of documents associated with Domino policies

Policy document
Contains one or more policy Settings documents

Settings documents

Define values for specific client configurations (mail, security, registration,
traveler, ...)

Linked to policy document(s)

Managed in the Domino Directory via the Domino Administrator
client

Most commonly via People & Group -> Policies

/ |

People & Groups | Files l Server... l Messaging..

Server: Notes! 1|
Release 14 0FPIHF34 on Linux

o C@ Domina Directaories
" EE OpenMTFs Directory
- ﬁ People

- ﬁ}ﬁ Groups
- .E% Mail-in Databases and Resources

» |4 Policies I
) mic Policies

& by Person/Group
Categaory

-

= Settings
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® Organizational

» Applied to users based on hierarchy (O / OU)
» Ex: */Sales/Acme, */Acme, ...

» Use for enterprise-wide standards

* Explicit
* Assigned to Users or Groups

« On the Policy Assignment tab of the explicit policy
document

- Note: assigned this way makes it a ‘Dynamic” policy
» During user registration
» By editing the user's Person document

» By using the Assign Policy tool in the Domino Administrator
client

e Best reserved for:

« Groups requiring specific settings (contractors, executives, IT
department, ...)

HCL Domino Types of Policies

\ 4

\4

Organizational
il Policies

li_fé Explicit Policies

\4

a& Dynamic Policies

- special type of Explicit Policy




Policies

® Settings documents
* Archiving Settings
« Controls archive location (local or server)
« Controls archive criteria

HCL Domino Policy Settings Hierarchy

&

Policy Document

* Desktop Settings f >
- Controls Notes client Ul (workspace, bookmarks), preferences and client behavior * W Archiving Settings
« Applied at setup and updated later - »
» Mail Settings » [ Desktop Settings
- Mail preferences, calendar behavior, delegation, ... : .
» Registration Settings * B4 Mail Settings
« Defaults for new user creation when registering users ; ”
 Roaming Settings i) Registration Settings )
» Controls Notes roaming configuration settings (
* Security Settings ’\ @ Roaming Settings |
« Controls password, execution control list (ECL), ID Vault and security options ( i ; )
: > O Security Settings
» Traveler Settings L )
» Mobile sync settings and mobile device access of []  Traveler Settings )
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Policies

Policy synopsis

ok CONSULTING., ITNC /
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Tool in the Domino Administration client < Tools
Use to determine effective policy settings for selected v @ People
user(s) Mo o At S
Output is directed to Policy Synopsis Results database e
(POLCYSYN.NSF) e
Tip: Store on Local rather than a server ‘;1":2"‘3"““"‘“"“
Invoked via People & Groups -> People -> Tools -> S
People -> Policy Synopsis Sl

Lpgrade... @



Policies — Policy Synopsis - Report Types
® Detailed
» Use for analyzing specific type(s) of
settings

® Summary only

o Default

» Provides an overall of all settings
documents applied - Select one of more settings types

Policy Synopsis E IE‘ Policy Synopsis E E
dischvepakcy strgstor . [FRG afecivepokcy setngetor . [ORGR
the selected useris). the selected users).
Show Puolicy Settings for: Cancs! Show Policy Settings far: Cancsl

Niklas H

Niklas Hi
Select Report Type: Select Report Type:
© Summary Only () Summary Only
() Detailed © Detailed
Archive
Dynamic Desktop | Dynamic Desktop |
Initial Desktop Setup

Initial Desktop Setup

Mail

Results Database:

Results Database:
© Append to this database © ~ppend to this database
() Overwrite this database () Ovenwrite this database
Results Database. Policy Synopsis Database on Local Results Database, Policy Synopsis Database on Local
Chooze the type of policy synopsis report you would like Choose the type of policy synopsis report you would like
generated. For a detailed report, choose which type(s) of generated. For a detailed report, choose which type(s) of
settings you want.

settings you want.
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Policies — Best Practices

Use ...

A
-

Organizational policies for broad defaults
Dynamic policies for fine tuning
Explicit policies for exceptions

Detail what each Policy and Settings document is intended to control in the
‘Description’ field
Ex:
“Default Settings for all Laptop Users”

Folicy - Mobile L apiafERe=s Policy : /Mobile Laptop Users

Basics l Policy Assignment l Paolicy Precedence l Comm Basice l Policy Assignment l e —— y

o = 2 . V24 . . r, . . ~ .
Default Reg|strat|on Sett|ngs Policy name: IMobile Laptop Users FD“C!-" Maobile Laptop Users
Paolicy type: T Explicit [
Diescription: " Default Settings for all Laptop Usersl__a

Category:
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Policies — Best Practices

Test policy changes with small group of users
Remember to utilize the Policy Synopsis tool

Review old policies regularly, especially when
Upgrading or retiring servers
Adding new sites or divisions



lnfirastructure
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DAQOS

Domino Attachment and Object Service
(DAOS)

Separates attachments from NSF databases

s

Stores attachments once in a shared
repository

Replaces attachments in documents with
references (pointers)

Attachments are stored as Notes Large Object
files

Can save a substantial amount of disk space

Domino

e

Bighle xis

Hugefile ppt
Podcast. mp3

e |

Bighile xis
Hugefile . ppt
Podcast. mp3

Bighile xis

Hugefile. ppt
Podcast. mp3

- — Ly

\\/

Dinny.nsf

Mike nsf

Ted nsf

%] bighle1 xis
@ )!J‘ hugepres ppt
£ Podcastmp3

DAOS
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DAOS folder should be located outside Domino data directory

Notes of caution
Do NOT manipulate the NLO files or the DAOS folders (unless instructed by HCL)
Set AV to not scan/act on DAOS folders and NLO files

For online backups, ensure NSFs are backed up PRIOR to the NLOs
Ensures all objects referenced by the NSF (NLOs) are backed up
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Tips for setting up
Choose whether or not to have NLOs encrypted with Server’s ID
Use the DAOS Estimator to determine best attachment size

DAOQOS catalog
Tracks object references and usage
Ensure have a Program Document to keep the DAOS catalog synchronized
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/Transactional Logging

Logs changes before committing them to a database
Records all changes made to Domino databases in a separate log file
Captures each database “transaction” (e.g., create/edit/save document)
Writes changes to a sequential transaction log first, then to the database later
Uses a set of log files (TXN extents) and a control file to track activity

Enable for data protection and faster recovery from crashes
Reduces downtime by enabling faster server restarts



el

Transactional Logging

Enables incremental backups, provided the backup solution has the capability

Tip:

Make sure use a separate disk or equivalent if using a SAN

Elasicsl Securityl Ports... ] Server Tasks... ] Internet Protocols. . ] MTAs... ] Misu:ellaneu:rusl] Transactional Logging \ Sh

Tran=sactional logging: Enabled

Log path: D:\DominoTransLogs
Logaing style: Circular

Use all available space on ¢~ voq 8 Mo

log device:

Maximum log space: 4096 MB

Automatic flxup of corrupt Enabled

databases:

Runtime/Restart Standard

performance:

Cluota enforcement: Check file size when extending the file
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Notes.inl Maintenance

Don’t leave debug enabled

Disable once issue debugging has been
resolved

Otherwise consumes valuable resources

Add comments when making changes

You will forget when and why debug was
added

Don’t forget about the Configuration
document!

Easicsl Securit_vl Client Upgrade | Routerd/SMTP | MIM

NOTES.IMNI Settings

Current parameters:CLUSTER_ADMIN_ON =1
CLUSTER_REPLICATORS=2
COMSOLE_LOG_EMABLED=1

COMSOLE_LOG_MAX_KBYTES=102400

Create_RS_DATABASES=1
DEFAULT_INDEX_LIFETIME_DAYS=14
DISABLE_BCC_GROUP_EXPAMSION=1

DONT_CACHE_MONITOR_FORMULAS=1

FTG_USE_SYS_MEMORY=1
HTTRJVMMaxHeapSizeSet=1
HTTRJVMMaxHeapSize=512M
PORTS=TCFIP
SERVER_SESSION_TIMEOUT=30
SERVER_TRAMSINFO_RANGE=12
UPDATE_FULLText_Thread=1

=1

HCL iMotes
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Upgrade Planning Steps

1. Inventory current environment
» Servers/VMs running Domino on
*» Domino release levels, fix packs, interim fixes, hotfixes
* Determine order in which want to upgrade

* Bxample Upgrade Order

DomMail01 2
DomMail02 3
DomMail01HA 1
DomTrav 4
DomNomad 5

* Where are servers located?
* Who will upgrade?
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ﬁ;de Planning Steps

2. Reference “System Requirements” document to determine if
- Hosting system will support version upgrading to
- Compatible OS level is being used

- Found here: https://support.hcl-software.com/csm?id=kb article&sysparm article=KB0073794

- Click link for desired release

Content

See the following articles for detailed system requirements for recent HCL Domino releases. These requirements list supported operating systems, system requirements, prerequisites, and optional
supported software.

Domino 14.5.1
System Requirements for HCL Domino 14.5.1

Domino 14.5
System Requirements for HCL Domino 14.5 Fix Pack 1

System Requirements for HCL Domino 14.5

Domino 14
System Requirements for HCL Domino 14.0 Fix Pack 5

System Requirements for HCL Domino 14.0, and 14.0 FP1, FP 2, FP3, and FP4

Domino 12
System Requirements for HCL Domino 12.0.2 and 12.0.2 FP1, FP2, FP3, FP4, FP5, FPG, FP7, and FP&



® Locate operating system details

Operating Systems

0s

Hardware Bitness
Windows Server 2019, 2022, 2025* (All editions)** %86-64 64-exploit
IBM AL 72 TLE+**** SPh+ Power9 b4-exploit
IBM AIX=** 73 TL1+ Power9, Power10 64-exploit

IBMi7.4,75 76 Power9, Power10

b4-exploit, 128-bit pointers

Red Hat Enterprise Linux (RHEL) Server 9.0+, 10.0+ **#+* x86-64

64-exploit

® Locate hardware details (disk space, memory)
» Keep in mind, these are “bare” minimums




ﬁde Planning Steps

3. Reference “What’s New” documentation for the release upgrading to

e  Example below for 14.5.1
. https://help.hcl-software.com/domino/14.5.1/admin/

What's newin 14.5.1?

HCL Domino 14.5.1 introduces these new features and enhancements.

General updates

Domino v14.5.1 includes component upgrades and other enhancements.

Configuration features
Domino 14.5.1 provides the following features and enhancements related to configuring users and servers.

Security updates

Security features and enhancements in Domino 14.5.1.

Administration features
Domino 14.5.1 provides the following new features and enhancements related to administering.

XPages: Support for multiple file uploads
The XPages file upload Ul now supports multiple selections by default.
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Determine if using Auto Update or doing upgrade Manually

Auto Update (Windows, Linux and AlX)
Introduced in Domino 14
Notifies, downloads, distributes updates
Updates the software catalog database (autoupdate.nsf)
Installation of updates starts in version 14.5
Windows and Linux only

AutoUpdate resources
HCL Domino v14 Deep Dive — Auto Update
https://www.youtube.com/watch?v=AT1tDzMDoPA
OpenNTF Webinar — Domino 14.5 Autolnstall Deep Dive
https://www.youtube.com/watch?v=pE 5FzgMKds
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Upgrade Planning Steps

Obtain necessary hotfix(es)

What is a hotfix?
Custom patch issued by HCL to fix a specific problem

e
.

Only one hotfix can be installed per server
Contact HCL Support to:

Determine if hotfix is included in a Fix Pack (FP)
If not, obtain new hotfix to work with Domino release and FP upgrading to
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Upgrade Planning Steps

Verify compatibility with extended products

Check prerequisites for extended products
Traveler

Enterprise Integrator (LEI / HEI)
HTMO

Nomad

Verify compatibility with 37 party add-on products
Check with vendor to ensure planned release is supported
Spam, anti-virus, mail signature, etc.

/ |
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Upgrade Planning Steps

Plan when to upgrade the Domino Directory design
Upgrade when server is upgraded?

What impact does this have on other servers?

Upgrade at a later time?

Plan when to upgrade the mail template(s)
Any customizations will need to be carried forward
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Upgrade Planning Steps

Review template customizations
Have any customizations been made to HCL-supplied templates?

Will custom templates inherit new desigh or must new templates be created and
deployed?

Have default ACL entries been modified?



11. Plan for the new On-Disk Structure (ODS) level, if applicable

On-Disk Structure defines how data is stored inside an NSF and feature/functions available

Most major releases have a new ODS level

o New features provided with each ODS level

A few examples:

ODS Level Examples of functionality enhancements
Level

5.0
8.0
8.5
9.0.1
10.0.x

12.0.x
14.0.x
14.5.x

ODS41
0ODS48
ODS51
ODS52
ODS53
ODS55

Participate in transactional logging

Design & document compression

Participate in DAOS

Numerous performance improvements

Maximum database size increased from 64 GB to 256 GB

Increase in allowed ACL entries & size allowed for individual summary fields
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Upgrade Planning Steps

Review notes.ini file(s)
Any debug needing to be disabled?
Any settings no longer needed?

Plan for upgrading the Notes clients
Two versions: Standard and Basic

Plan to test custom applications at new release m
Most over looked step!!

Remember to plan for testing upgrade to BOTH Client and Server levels
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Upgrade Planning Steps

Obtain Domino installation media (if doing manual upgrade)
Download from My HCLSoftware Portal

https://my.hcltechsw.com/downloads
Click ‘HCL Domino’ -> ‘Domino’

Choose the appropriate release ==

‘ 14.5.1 14.5 14.0 12.0.2 12.0.1 11.0.1
Name Released |,
14.5.1 Interim Fix 1 20 May 2026
14.5.1 19 Mar 2026

Click on the appropriate links to download the required software

Releases
‘ 14.5.1 14.5 14.0 12.0.2 12.0.1 11.0.1 ‘
Name Released J,
14.5 Fix Pack 1 29 Sep 2025
145 17 Jun 2025


https://my.hcltechsw.com/downloads
https://my.hcltechsw.com/downloads
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Templates

What is a template?
A “blueprint” used to create or update the design of one or more databases

Why use templates?

Consistency: Databases created from the same template have the same forms, views,
agents, actions, and design structure

Efficiency: Design updates can be applied broadly without manually editing every
database

Standardization: Mail files, system databases, and custom applications can follow a
known approved design

Controlled Change Management: Template updates can be developed, tested, approved,
and then deployed
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‘Templates

NSF = Notes Storage Facility
Domino application/database (mail file, custom application, ...)
Contains both design and data

NTF = Notes Template Facility
Contains design only

Many templates ship with a Domino server (HCL Standard Templates)

Domino directory, mail templates, discussion database, document library, ...
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Templates

Template .vs. Database

A database should have:
File extension of .nsf

Property set:

Database Properties -> Inheritance -> Inherit Design from Master Template -> Template
Name

A template should have:
File extension of .ntf

Property set:
Database Properties -> Database file is a master template -> Template Name



Templates

Database

Database - = 7 X
Cili|lalaelsla =]

ML =Rl My Old Mail File

Server  Local
Filename  MyQldMailFile nsf

Type  Standard -

Archive Settings Encryption Settings

Settings

Replication Settings Replication History
¥ Lse JavaScrpt when generating pages

Web Require 55L connection

Access Dont allow URL open

Enable enhanced HTML generation

v Dont allow open in HCL Client Application
Access

Disable background agents for this database
¥ Allow use of stored forms in this database
Digplay images after loading
Allow document locking
Allow connections to extemal databases using DCRs

v Inhert operating system theme from Maotes preferences

Database - C I I

elil&

Design iz not hidden

Al = |

Options
Allow design locking
v List in Database Catalog
Categories
¥ Show in Open Application” dialog
Include in mutti-database indexing
¥ Do not mark modified documents as unread
¥ Mark parent note on reply or forward

Inhertance

¥ Inherit design from master template
Template name  StdR11Mail
Template version is 11.0.1 (2020-02-07)

Refresh design on admin server only
Database file is @ master template
Template name
List as advanced template in "Mew Application” dialog
Copy profile documents with design
Single copy template

kil ikilimanial Mirdioeme

Template

Database - mn g oy
. B
ileslaelslal=m]

Title  Mail (R11.0.7}
Server Local
Filename  mail11.ntf
Type  Standard -
Archive Settings Encryption Settings
Settings
Replication Settings Replication History
¥ Use JavaScrpt when generating pages
Web Require S5L connection
Arccess Dont allow URL open

Enable enhanced HTML generation

w Dont allow open in HCL Client Application
Access

Disable background agents for this database
¥ Allow use of stored forms in this database
Display images after loading
Allow document locking
Allow connections to extemal databases using DCRs

v Inherit operating system theme from Motes preferences

n:n:l"?x

Database -
@ | ils |

Design is not hidden

2l = |

Options
Allow design locking
v List in Database Catalog
Categories
¥ Show in Open Application’ dialog
Include in multi-database indexing
¥ Do not mark modffied documents as unread
¥ Mark parent note on reply or forward

Inhertance
Inhert design from master template
Template name
Template version is 11.0.1 (2020-02-07)

Refresh design on admin server anly
¥ Database file is a master template
Template name  StdR11Mail
List az advanced template in "New Application’ dialog
Copy profile documents with design
Single copy template

M kiliman sl Mirticms
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Templates

Design Inheritance

When a database is set to Inherit from a template, changes will take effect:
Automatically when the Design task runs on the server
Manually from the console with a Load Convert command
Manually in the Notes Client or the Domino Administrator Client

Select the database I g Lo
File Edit View Create Actions Tools Window Help
. ] . . MNew >
Click File -> Application e
Close Esc
. H H I
Refresh Design... or
AutoSav H M
L] Application > [E] Properties
Replace Deslgn." Replication > O Access Control.
Locations ]
Page Setup... Mew... Ctrl+N
Prefi Mew Copy...
Properties Alt+Enter Publish...
5 ty Delete...
Change Password Archive.
Close All Refresh Design...
Replace Design...




Templates

Refresh Design
Updates design elements for a database whose design is linked to a template
Can preserve customized design elements

Replace Design
Replaces the database design with the selected template

Same template or a different template

Can overwrite customizations
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Templates

"Prohibit design refresh or replace to modify“

“KIM GREEN
22
-

Design elements can have this property checked

Can lead to unexpected results when a Design Refresh or Replace is performed

Tip: Open in Designer client to confirm

E= Properties X /= Events X B Problems X

—#

| -

Infa Design Source

Fields Inherit from the design template
i Design

Document [ds . : :
B Prohibit design refresh or replace to modify
[[] Propagate this prohibition of design change

|| Do not show this design element in menus of MNotes R4 or later clients
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Templates

Template Title .vs. Template Name .vs. Filename

This can confuse new Administrators
In the example, we have:
Template Title: Mail (R11.0.1)
Template Name: StdR11Mail

Filename: mailll.ntf

- o 7 X

leslal #la =]
Title  Mail (R11.0.1)

Server Local

Flename  mail11.ntf

Type Standard -

Archive Settings Encryption Settings

Settings
Replication Settings Replication History

¥ Use JavaScript when generating pages
Web Require S5L connection
Access Dont allow LRL open

Enable enhanced HTML generation

v Dont allow open in HCL Client Application
Access

Disable background agents for this database
v Allow use of stored forms in this database
Display images after loading
Allow document locking
Allow connections to extemnal databases using DCRs

v Inhert operating system theme from MNotes preferences

Database - mm g X

@ | i|ls

Design is not hidden

2=

Options
Allow design locking
v List in Database Catalog
Categories
¥ Show in 'Open Application’ dialog
Include in multi-database indexing
¥ Do not mark medified documents as unread
¥ Mark parent note on reply or forward

Inheritance
Inherit design from master template
Template name
Template version iz 11.0.1 (2020-02-07)

Refresh design on admin server only
v Database file iz a master template
Template name  StdR11Mail
List as advanced template in "New Application’ dialog
Copy profile documents with design
Single copy template

Ky bilimmn 12l Mirdinme
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Templates

Performing a Load Convert
Syntax: load convert <database-path> <current-template-name> <new-template-file>

For mail template upgrades on a single mail file:
load convert mail\MyOIldMailFile.nsf * maill14.ntf

For mail template upgrades on multiple mail files:

Only update the mail files that have a specific template:
load convert mail\*.nsf StdR11Mail maill4.ntf

Update all mail files in the mail directory, regardless of the current template used:
load convert mail\*.nsf * maill4.ntf



-
Templates

Best Practices
Never edit standard HCL templates directly

Make a copy of the template if customization is required
Give the new template a new Template Name

Test template changes before applying broadly
Back up databases before major design changes
Document any customized templates
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“Language Packs

Default language is English

Can replace English or install additional languages
Most common is to Add additional languages

Allows administrators to add translated

Templates (mail, discussion, document library...)
Can customize which templates are updated

Help files
Core binary files
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“Language Packs

Server
Modifies HCL supplied templates and web rendering

Can customize which templates to update

Client
Multilingual User Interface (MUI)
Changes language of menus, buttons & sidebars with Notes client

OS provides local language functions for keyboard
Translates templates to local language
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Language Packs

Convert tool
Used to replace database’s design to a specific language
load convert —g”language”

load convert —g”German” mail/kgreene.nsf * maill4.ntf
load convert —g”ChineseSimplified” mail/msmith.nsf * maill12.ntf

Re p I a Ce d es ig n O pt i O n Select Template Languages
Avail-.flble |anguages Selected Imguag_es
File -> Application -> Replace Design Erolh add___ | [PotugueselBiazi
Portuguese[Brazil] Fra

Select language in dialog box




Language Packs

® Select “Preferred Language” when registering a user

Register Person -- New Entry

Setup profile Unigque org unit: Location:

'EL Basics
(Mone Available) e |

=) Mail
Local administrator: Comment:

4 Address

& ID Info

Choose an altemate name language to enable altemate name and org unit

.
&4 Grouy Altemate name languaas: Altemiate name: Altemate org unit:
3 Roaming {Nane) w

@ Other refemed language: \

{Mone) e

AMrikaans
Albanian
Arabic
Arabic{flgeria)
Arabic(Bahrain)
Arabic{Eaypt)
Arabic{Jordan)

B Advanced [ﬁ:g:zigﬁ:ﬂn} e People... I | Import Text File..

Registration Qudlie Arabic(Morocca)
Arabic{Oman)

” |User rlarﬂrabic{ﬂatar} Lgistration Status ~ Date ~

Arabic({Saudi Arabia)
Arabic(Syria)
Arabic(Tunisia)
Arabic({United Arab Emirate:
Arabic(Yemen)

Bulgarian

Byelorussian

Eﬁ:l:sr;{(:hina} e | Options... I | Views ... I | Done
\Chinese(Hong Kong SAR) /l






“KIM GREEN
m%%f-:}.:: COHNSULTING., | C

[

Semaphore Timeouts

What is a semaphore?

Mechanism used to control access to shared resources
Ensures

Data consistency

Controlled access to databases, memory and processes
Like a traffic light

Only one thread uses a resource at a time
Others must wait in a queue
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Semaphore Timeouts

How a Semaphore Timeout Happens

Example: 0931 Task sync semaphore

b

ijt Domino Server

N

o < e N 7 o . B ~
n Task A
gets delayed ‘
' Its work slows down -
or hangs.
Task A P Commoncauses | M| Task B needs P Task Bwaits ™P|  Semaphore
gets the lock ) slow disk the same lock too long timeout is logged
Task A starts work Q long operation | Another Domino The wait exceeds Domino reports:

and acquires the
task sync semaphore.

)

B8 blocked /0

L A hung task

thread wants the the timeout limit.
same shared

resource.

J

0931 Task sync
semaphore

0 What this means

' Usually the timeout is a symptom.
\

. The real issue is that Task A held the lock too long.
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- Semaphore Timeouts

®* What is a semaphore timeout?

» A thread wait too long for a resource
» 30 seconds or longer

® When does it matter?

* Impacts performance
» Slow or unresponsive behavior
» Resource contention
- Many tasks competing for same resource
» Dead locks
- Extreme impact to server performance
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Semaphore Timeouts

Deadlocks
Two or more threads waiting on each other or the same resource
End result = system appears “hung”

Determining if semaphore timeouts are happening

sh stat sem
If none exist:
SEM not found in server statistics table

If timeouts exist, Sem.Timeouts= contains list of semaphore timeouts
Sem.Timeouts = 4A12:265 1120:126 2B06:86 1136:85 117C:44 1135:25 BAE4:8 0931:1
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Semaphore Timeouts

Understanding ‘sh stat sem’ output
Sem.Timeouts= XXxx:yyy
XXXX = semaphore timeout number
:yYY = number of times semaphore has happened since last server restart

e
.

Normal to see zero to a handful of semaphore timeouts on a healthy server

When to be concerned

:yyy is a high number
OR

:yyy is quickly climbing in value

S CONSULTING, INC /
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Semaphore Timeouts

When to be concerned

e
.

Customer example
Reports server is hung
Server tasks are still active
Number of semaphore timeouts climbing quickly, ‘sh stat sem’ shows
Initially shows: Sem.Timeouts = 042D:15518
20 seconds later: Sem.Timeouts = 042D:15596
78 new semaphore timeouts in a 20 second time range!
042D identifies LSIWRAP SHARED SEMAPHORE

Relates to the LotusScript Wrapper—meaning a script, agent, or Domino-integrated Java
function is deadlocked or taking too long to execute
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Performance — Where to Start?

ok IH

Know what’s “norma
Start with system level performance
Focus on key Domino statistics

Understand impact of semaphore timeouts
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Performance — System Statistics

* Need tool to gather statistics for system as a whole
® Capture statistics on:

* CPU
* Memory
Disk I/O
Network 1/0
®* Some examples

* Perfmon

* Perfpmr

°* nmon

e Vstat

» Collection Services

¢ jostat

* netstat

CPU Utilization (Average) [=iE
100 -
80 - 4 : : 1
sol 5 m,l-\‘_.w“_.
40 - 4 4 ' 4
20 - : -
0 a 1 Ll T 1 T T 1 1 ) 1 1 1 1 1 1 Ll 1 1 1 1
10:33 10:34 10:35 10:36 10:37 10:3
A | 5
User Pool Faults (Maximum) ! [5
200 - .
150 -
100 -
50 ...__..-—H—_.*‘—l\ ! . . il
o, o= oz a2 o3
0 3 i 1 ) 1 1 1 1 h 1 Te i 1 1 1 1 1 1 1 1 i 1
10:33 10:34 10:35 10:36 10:37 103
4 | i
Disk Arm Utilization (Maximum) | =E
100 - -
30 - |
60 - |
40 - ‘
R Smrpm— S ———— — ‘
] A 1 1 1 1 1 1 I 1 Ll 1 Ll 1 1 ) 1 1 1 1 1
10:33 10:34 10:35 10:36 10:37 10:2
Kl | i

¢l ‘ [



200 --
190 -
180 -

170 -

160 -

160 <+

140 -
130 -
120
110 -
100 -
90 -
80 -
70 - t
60 -

50 -- !

40 -

30 -- !

20 -
10 -

o & L
12:00 AM

C 600AM  1200PM

C 600PM  1200AM

C G00AM  1200PM  6O00PM  1200AM

Performance — System Memory Example

* Impact on CPU by properly optimizing system memory allocation

i G:Odm




Performance — Impact of Disk Configuration

* Windows server example
» Pages/Sec: rate memory pages are read from or written to disk

Average Minimum  Maximum
509.532 0.000 57655.272
15142.617 9.426 358717.153

« ~2872% increase in average pages/second with SSD

» Page Faults/Sec: rate at which processes request memory pages not immediately available in their

working set

Average Minimum  Maximum

22586.549 14.238  400898.185
515.820 0.000 25800.639

» ~98% reduction in average page faults/second



|

Collect statistics regularly
sh stat

To limit to specific area (examples):
sh stat database (309 stats)
sh stat http (50 stats)
sh stat mail (179 stats)
sh stat platform (224 stats)

Critical areas of focus:
Domino memory management
Mail statistics
Cache sizes
Transaction rates
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nified Buffer

Buffers data between the Notes Indexing Facility (NIF) and disk
Reduces disk reads/writes by keeping database pages in memory

Manager
Also referred to as the NSF buffer pool

Domino’s own memory manager

NIF

=

NSF Buffer Pool

=

~ N

N -
Disk

8 >
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“Unified Buffer Manager

sh stat database

e
.

Key statistics with example

Database.Database.BufferPool.Maximum.Megabytes = 1024
Maximum size NSF buffer pool can be

Database.Database.BufferPool.Peak.Megabytes = 1023
Largest size NSF buffer pool has been since server restart

Database.Database.BufferPool.PercentReadsInBuffer = 99.44
Want >= 95% reads in buffer

Adjust with this notes.ini variable
NSF_BUFFER_POOL_SIZE_MB=
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atabase Cache

Determines the number of databases a server can hold in its cache

e

Defaults to 3x size of NSF buffer pool

Key statistics with example
Database.DbCache.CurrentEntries = 1213
Database.DbCache.HighWaterMark = 1350
Database.DbCache.MaxEntries = 900

Database.DbCache.OvercrowdingRejections = 157,580
Should be zero on a healthy system!

Adjust with this notes.ini variable
NSF DbCache Maxentries=
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“Number of Mail.Box Files

e sh stat mail

» Key statistics
o Mail.Mailbox.Accesses

» Mail.Mailbox.AccessConflicts

 Want < 2% conflicts
- Mail.Mailbox.AccessConflicts / Mail.Mailbox.Accesses = < 0.02

Mail Delivery Statistic After Tuning

Mail.Mailbox.AccessConflicts 1151 8
Mail.Mailbox.Accesses 3877 3023

Server.MailBoxes 2 4
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monitor Pool

Caches event monitors such as server and user mail rules

e
.

sh stat database

Key statistics with example
Database.MonitorPool.Event.Used = 52309
Database.MonitorPool.Monitors.Used = 1184
Database.MonitorPool.Size = 41943040

Check the log for the error “Insufficient memory — NSF monitor pool is full”

Adjust with this notes.ini variable
NSF_MONITOR POOL _SIZE MB=

e — s
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" Full Text Index Tuning

Spawn full-text indexing off to own thread
Prevents long full text indexing operations from delaying view updates
By default, view updates and full text indexing are driven by the same thread

Key statistics with example
FT.Index.Count = 56,150
FT.Index.Search = 27,652
FT.Search.Total.Results = 1,002,317

Enable with this notes.ini variable
Update Fulltext Thread=1

/ |
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Customer Tuning Example

» Semaphore timeouts

Semaphore | # of times | Description
Timeout occurring

3A05 793 SEM_HTTP_AGENT

0266 20 NSF per-database full-text semaphore
0244 15 NSF per-database semaphore

0931 8 Task sync semaphore

03A8 2 DBCONT page zero semaphore

* Enabling Update Fulltext Thread=1 eliminated semaphore timeouts



onitor Size of Logging Databases

Common for agents to write to logging databases as they process data

Keep these logging databases small
Examples: log.nsf, domlog.nsf, custom logging database

/V

Have seen a number of semaphore timeout issues and HTTP thread
locking issues with large logging databases

Recommend archiving / purging documents out of logging databases
on regular basis
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Mixing Applications and Mail

* Where do you deploy applications?
* Mail server
* Application server

® Understand impact of updates

» Update task works off queue
* FIFO
» Can get erratic performance when mixing mail and application
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SSL Certificates

What the heck are they?

A digital data file hosted on a website’s server
Acts as an electronic passport
Verifies the sites’ identify
Enables encrypted connections between users and the server

Provides encrypted connections to Domino services
HTTPS / HCL Verse / iNotes
Traveler / HTMO
Nomad
SMTP
IMAP / POP3
LDAP

/ |
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SSL Certificate Renewals

Two ways to process Domino certificate renewals

Manually
Utilizes keyring (.kyr) and stash (.sth) files
Tools required:
OpenSSL
KYRTool

Certificate Manager / CertStore
Introduced in Domino 12
Uses certstore.nsf to manage certificates across domains
New CertMgr task
* Supported on Windows, Linux, AIX, Docker/Containers
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Certificate Renewal Workflow

These steps are the same regardless of the renewal process chosen

Identify expiring certificate
Confirm affected Domino services/servers
Confirm renewal method

Manual or Certificate Manager

Generate or obtain renewed certificate

Import or update certificate and intermediate chains
Update certificate on required Domino server(s)

Restart tasks/server and confirm new certificate is in use
Test, test, test
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Certificate Renewal Process

®* Manually

e https://support.hcl-
software.com/csm?id=kb article&sysparm article=KB0033348

® Certificate Manager process

e https://help.hcl-
software.com/domino/14.5.1/admin/secu le using certificate manager.html



https://support.hcl-software.com/csm?id=kb_article&sysparm_article=KB0033348
https://support.hcl-software.com/csm?id=kb_article&sysparm_article=KB0033348
https://support.hcl-software.com/csm?id=kb_article&sysparm_article=KB0033348
https://support.hcl-software.com/csm?id=kb_article&sysparm_article=KB0033348
https://help.hcl-software.com/domino/14.5.1/admin/secu_le_using_certificate_manager.html
https://help.hcl-software.com/domino/14.5.1/admin/secu_le_using_certificate_manager.html
https://help.hcl-software.com/domino/14.5.1/admin/secu_le_using_certificate_manager.html
https://help.hcl-software.com/domino/14.5.1/admin/secu_le_using_certificate_manager.html
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What You Should Be Doing and When

Daily

Check the Administration Requests application - Admin4.nsf

Approvals, ...
Console

Know what is “norma
Errors in logs

Log.nsf

Domlog.nsf

Custom logging database
Monitor servers

Recent reboots

Dead mail, pending mail queues, DNS availability
Backups

III
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What You Should Be Doing and When

Weekly
Domino Domain Monitoring (DDM) reports
Server disk space

Monthly

Cluster analysis

Missing and duplicate replicas

Note counter discrepancies across replicas
Performance

System level
Domino level
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What You Should Be Doing and When

Quarterly
Cluster failover testing
Restore from backup
Fix pack availability

Yearly
Upgrades
User audit
Verify person documents are valid
Datacenter failover

Full review of configuration
Server, Configuration, Connection, Program, Internet Site, .... documents






Contact Information

m www.linkedin.com/in/kimgreeneconsulting
B @iSeriesDomino

kim@kimgreene.com
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